Creating a Simple Application
To finish your exploration of the IDE, you need to create a project so that the windows shown earlier in Figure 1.3 have some interesting content for you to look at.
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Try It Out: Creating a Hello User Project
In this Try It Out exercise, you will create a very simple application called Hello User that will allow you to enter a person's name and display a greeting to that person in a message box:
1. Click the New Project button on the toolbar.
2. In the New Project dialog, select Visual Basic in the Installed Templates tree-view box to the left and then select Windows beneath it. The Templates pane on the right will display all the available templates for the project type chosen. Select the Windows Forms Application template.
3. Type Hello User in the Name text box and click OK. Your New Project dialog should look like Figure 1.6.
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Figure 1.6

Visual Studio 2012 allows you to target your application to a specific version of the Microsoft .NET Framework. The combo box at the top of the Templates pane in the New Project dialog has version 4.5 selected, but you can target your application to earlier versions of the .NET Framework.
The IDE then creates an empty Windows application for you. So far, your Hello User program consists of one blank window, called a Windows Form (or sometimes just a form), with the default name of Form1.vb, as shown in Figure 1.7.
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Figure 1.7
Whenever Visual Studio 2012 creates a new file, either as part of the project creation process or when you create a new file, it will use a name that describes what it is (in this case, a form) followed by a number.
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At this point, you can see that the various windows in the IDE are beginning to show their purposes, and you should take a brief look at them now before you come back to the Try It Out exercise.
	
	Note 
	If any of these windows are not visible on your screen, you can use the View menu to show them. Also, if you do not like the location of any particular window, you can move it by clicking its title bar and dragging it to a new location. The windows in the IDE can float (stand out on their own) or be docked (as they appear in Figure 1.7).


The following list introduces the most common windows:
· Toolbox: This contains reusable controls and components that can be added to your application. These range from buttons to data connectors to customized controls that you have either purchased or developed.
· Design window: This window is where a lot of the action takes place. This is where you will draw your user interface on your forms. This window is sometimes referred to as the Designer.
· Solution Explorer: This window contains a hierarchical view of your solution. A solution can contain many projects, whereas a project contains forms, classes, modules, and components that solve a particular problem.
· Properties: This window shows what properties the selected object makes available. Although you can set these properties in your code, sometimes it is much easier to set them while you are designing your application (for example, drawing the controls on your form). You will notice that the File Name property has the value Form1.vb. This is the physical filename for the form's code and layout information.
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Try It Out: Creating a Hello User Project (continued)
Next, you'll give your form a name and set a few properties for it:
1. Change the name of your form to something more indicative of your application. Click Form1.vb in the Solution Explorer window. Then, in the Properties window, change the File Name property from Form1.vb to
2. 
3. HelloUser.vb
and press Enter, as shown in Figure 1.8.
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Figure 1.8
4. When changing properties you must either press Enter or click another property for it to take effect. Note that the form's filename has also been updated in the Solution Explorer to read HelloUser.vb.
5. Click the form displayed in the Design window. The Properties window will change to display the form's Form properties (instead of the File properties, which you have just been looking at).
	
	Note 
	The Properties window is dramatically different. This difference is the result of two different views of the same file. When the form name is highlighted in the Solution Explorer window, the physical file properties of the form are displayed. When the form in the Design window is highlighted, the visual properties and logical properties of the form are displayed.


6. The Properties window allows you to set a control's properties easily. Properties are a particular object's set of internal data; they usually describe appearance or behavior. In Figure 1.9 you can see that properties are displayed alphabetically. The properties can also be grouped together in categories: Accessibility, Appearance, Behavior, Data, Design, Focus, Layout, Misc, and Window Style.
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Figure 1.9
8. Right now, the title (Text property) of your form (displayed in the bar at the top of the form) is Form1. This is not very descriptive, so change it to reflect the purpose of this application. Locate the Text property in the Properties window. Change the Text property's value to Hello from Visual Basic 2012 and press Enter. Note that the form's title has been updated to reflect the change.
	
	Note 
	If you have trouble finding properties, click the little AZ icon on the toolbar toward the top of the Properties window. This changes the property listing from being ordered by category to being ordered by name.


9. You are now finished with this procedure. Click the Start button on the Visual Studio 2012 toolbar (the green triangle) to run the application. As you work through the book, whenever we say “run the project” or “start the project,” just click the Start button. An empty window with the title Hello from Visual Basic 2012 is displayed.

That was simple, but your little application isn't doing much at the moment. Let's make it a little more interactive. To do this, you will add some controls—a label, a text box, and two buttons—to the form. This will enable you to see how the Toolbox makes adding functionality quite simple. You may be wondering at this point when you will actually look at some code. Soon! The great thing about Visual Basic 2012 is that you can develop a fair amount of your application without writing any code. Sure, the code is still there, behind the scenes, but as you will see, Visual Basic 2012 writes a lot of it for you.
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The Toolbox is accessed through the View ⇨ Toolbox menu option, by clicking the Toolbox icon on the Standard menu bar, or by pressing Ctrl+Alt+X. Alternatively, the Toolbox tab is displayed on the left of the IDE; hovering your mouse over this tab will cause the Toolbox window to fly out, partially covering your form.
The Toolbox contains a Node-type view of the various controls and components that can be placed onto your form. Controls such as text boxes, buttons, radio buttons, and combo boxes can be selected and then drawn onto your form. For the HelloUser application, you'll use only the controls in the Common Controls node. Figure 1.10 shows a listing of common controls for Windows Forms.
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Figure 1.10
Controls can be added to your forms in any order, so it doesn't matter whether you add the label control after the text box or the buttons before the label.
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Try It Out: Adding Controls to the HelloUser Application
In the following Try It Out exercise, you start adding controls.
1. Stop the project if it is still running because you now want to add some controls to your form. The simplest way to stop your project is to click the close (X) button in the top-right corner of the form. Alternatively, you can click the blue square on the toolbar (which displays a ToolTip that says “Stop Debugging” if you hover over it with your mouse pointer).
2. Add a Label control to the form. Click Label in the Toolbox, drag it over to the form's Designer, and drop it in the desired location. (You can also place controls on your form by double-clicking the required control in the Toolbox or clicking the control in the Toolbox and then drawing it on the form.)
3. If the Label control you have just drawn is not in the desired location, no problem. When the control is on the form, you can resize it or move it around. Figure 1.11 shows what the control looks like after you place it on the form. To move it, click the control and drag it to the desired location. The label will automatically resize itself to fit the text that you enter in the Text property.
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Figure 1.11
4. After drawing a control on the form, you should at least configure its name and the text that it will display. You will see that the Properties window to the right of the Designer has changed to Label1, telling you that you are currently examining the properties for the label. In the Properties window, set your new label's Text property to Enter Your Name. Note that after you press Enter or click another property, the label on the form has automatically resized itself to fit the text in the Text property. Now set the Name property to lblName.
5. Directly beneath the label, you want to add a text box so that you can enter a name. You will repeat the procedure you followed for adding the label, but this time make sure you select the TextBox control from the toolbar. After you have dragged and dropped (or double-clicked) the control into the appropriate position as shown in Figure 1.12, use the Properties window to set its Name property to txtName. Notice the sizing handles on the left and right side of the control. You can use these handles to resize the text box horizontally.
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Figure 1.12
6. In the bottom-left corner of the form, add a Button control in exactly the same manner as you added the label and text box. Set its Name property to btnOK and its Text property to &OK. Your form should now look similar to the one shown in Figure 1.13.
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Figure 1.13
The ampersand (&) is used in the Text property of buttons to create a keyboard shortcut (known as a hot key). The letter with the & sign placed in front of it will become underlined (as shown in Figure 1.13) to signal users that they can select that button by pressing the Alt+letter key combination, instead of using the mouse (on some configurations the underline doesn't appear until the user presses Alt). In this particular instance, pressing Alt+O would be the same as clicking the OK button. There is no need to write code to accomplish this.
7. Now add a second Button control to the bottom-right corner of the form by dragging the Button control from the Toolbox onto your form. Notice that as you get close to the bottom right of the form, a blue snap line appears, as shown in Figure 1.14. This snap line enables you to align this new Button control with the existing Button control on the form. The snap lines assist you in aligning controls to the left, right, top, or bottom of each other, depending on where you are trying to position the new control. The light blue line provides you with a consistent margin between the edge of your control and the edge of the form. Set the Name property to btnExit and the Text property to E&xit. Your form should look similar to Figure 1.15.
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Figure 1.14
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Figure 1.15

Now, before you finish your sample application, the following section briefly discusses some coding practices that you should be using.
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You might have noticed that the names given to the controls look a little funny. Each name is prefixed with a shorthand identifier describing the type of control it is. This makes it much easier to understand what type of control you are working with as you look through the code. For example, say you had a control called simply Name, without a prefix of lbl or txt. You would not know whether you were working with a text box that accepted a name or with a label that displayed a name. Imagine if, in the previous Try It Out exercise, you had named your label Name1 and your text box Name2—you would very quickly become confused. What if you left your application for a month or two and then came back to it to make some changes?
When working with other developers, it is very important to keep the coding style consistent. One of the most commonly used styles for control names within application development in many languages was designed by Dr. Charles Simonyi, who worked for the Xerox Palo Alto Research Center (XPARC) before joining Microsoft. He came up with short prefix mnemonics that allowed programmers to easily identify the type of information a variable might contain. Because Simonyi is from Hungary, and the prefixes make the names look a little foreign, this naming system became known as Hungarian Notation. The original notation was used in C/C++ development, so the notation for Visual Basic 2012 is termed Modified Hungarian Notation. Table 1.1 shows some of the commonly used prefixes that you'll utilize in this book.
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	Control
	Prefix

	Button
	btn

	ComboBox
	cbo

	CheckBox
	chk

	Label
	lbl

	ListBox
	lst

	MainMenu
	mnu

	RadioButton
	rdb

	PictureBox
	pic

	TextBox
	txt


Hungarian Notation can be a real time-saver when you are looking at either code someone else wrote or code that you wrote months earlier. However, by far the most important thing is to be consistent in your naming. When you start coding, choose a convention for your naming. It is recommended that you use the de facto standard Modified-Hungarian for Visual Basic 2012, but it is not required. After you pick a convention, stick to it. When modifying others' code, use theirs. A standard naming convention followed throughout a project will save countless hours when the application is maintained. Now let's get back to the application. It's time to write some code.
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Now that you have the HelloUser form defined, you have to add some code to make it actually do something interesting. You have already seen how easy it is to add controls to a form. Providing the functionality behind those on-screen elements is no more difficult. To add the code for a control, you just double-click the control in question. This opens the Code Editor in the main window, shown in Figure 1.16.
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Figure 1.16
Note that an additional tab has been created in the main window. Now you have the Design tab and the Code tab, each containing the name of the form you are working on. You draw the controls on your form in the Design tab, and you write code for your form in the Code tab. One thing to note here is that Visual Studio 2012 has created a separate file for the code. The visualdefinition and the code behind it exist in separate files: HelloUser.Designer.vb and HelloUser.vb. This is actually the reason why building applications with Visual Basic 2012 is so slick and easy. Using the design mode you can visually lay out your application; then, using Code view, you add just the bits of code to implement your desired functionality.
Note also the two combo boxes at the top of the window. They provide shortcuts to the various parts of your code. The combo box on the left is the Class Name combo box. If you expand this combo box, you will see a list of all the objects within your form. The combo box on the right is the Method Name combo box. If you expand this combo box, you will see a list of all defined functions and events for the object selected in the Class Name combo box. If this particular form had a lot of code behind it, these combo boxes would make navigating to the desired code area very quick—jumping to the selected area in your code. However, all the code for this project so far fits in the window, so there aren't a lot of places to get lost.
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Try It Out: Adding Code to the Hello User Project
1. To begin adding the necessary code, click the Design tab to show the form again. Then double-click the OK button. The code window will open with the following code. This is shell of the button's Click event and the place where you enter the code that you want to run when you click the button. This code is known as an event handler, sometimes also referred to as an event procedure:
2. Private Sub btnOK_Click(sender As Object, e As EventArgs) 
3.     Handles btnOK.Click    
4. 
5. End Sub
As a result of the typographic constraints in publishing, it may not be possible to put the Sub declaration on one line. Visual Basic 2012 allows you to break up lines of code by using the underscore character (_) to signify a line continuation. The space before the underscore is required. Any whitespace preceding the code on the following line is ignored. In some cases, you can break a line of code without the underscore as shown in the code that follows. You will learn more about the rules of breaking lines later.

Private Sub btnOK_Click(sender As Object, 
    e As EventArgs) Handles btnOK.Click

End Sub
Sub is an example of a keyword. In programming terms, a keyword is a special word that is used to tell Visual Basic 2012 to do something special. In this case, it tells Visual Basic 2012 that this is a subroutine, a procedure that does not return a value. Anything that you type between the lines Private Sub and End Sub will make up the event procedure for the OK button.
6. Now add the bolded code to the procedure:
7. Private Sub btnOK_Click(ByVal sender As System.Object, _
8. 
9.     ByVal e As System.EventArgs) Handles btnOK.Click
10.     ‘Display a message box greeting to the user
11.     MessageBox.Show("Hello, " & txtName.Text & _
12.         "! Welcome to Visual Basic 2010.", _
13.         "Hello User Message")
14. End Sub
Throughout this book, you will be presented with code that you should enter into your program if you are following along. Usually, I will make it pretty obvious where you put the code, but as I go, I will explain anything that looks out of the ordinary. The code with the gray background is code that you should enter.
15. After you have added the preceding code, go back to the Design tab and double-click the Exit button. Add the following bolded code to the btnExit_Click event procedure:
16. Private Sub btnExit_Click(sender As Object, 
17.     e As EventArgs) Handles btnExit.Click
18.     ‘End the program and close the form
19.     Me.Close()
20. End Sub
21. Now that the code is finished, the moment of truth has arrived and you can see your creation. First, however, save your work by using File ⇨ Save All from the menu or by clicking the Save All button on the toolbar. The Save Project dialog is displayed, as shown in Figure 1.17, prompting you for a name and location for saving the project.
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Figure 1.17
By default, a project is saved in a folder with the project name; in this case, Hello User. Because this is the only project in the solution, there is no need to create a separate folder for the solution, which contains the same name as the project, thus the “Create directory for solution” check box is unselected.
22. Now click the Start button on the toolbar. At this point, Visual Studio 2012 will compile the code. Compiling is the activity of taking the Visual Basic 2012 source code that you have written and translating it into a form that the computer understands. After the compilation is complete, Visual Studio 2012 runs (also known as executes) the program, and you'll be able to see the results.
Any errors that Visual Basic 2012 encounters will display as tasks in the Error List window. Double-clicking a task transports you to the offending line of code. You will learn more about how to debug the errors in your code in Chapter 10.
23. When the application loads, you see the main form. Enter a name and click OK or press the Alt+O key combination (see Figure 1.18).
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Figure 1.18
A window known as a message box appears as shown in Figure 1.19, welcoming the person whose name was entered in the text box on the form—in this case, Chris.
24. After you close the message box by clicking the OK button, click the Exit button on your form. The application closes and you will be returned to the Visual Studio 2012IDE.
How It Works
The code that you added to the Click event for the OK button will take the name that was entered in the text box and use it as part of the message that was displayed in Figure 1.19.
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Figure 1.19
The first line of text you entered in this procedure ('Display a message box greeting to the user) is actually a comment, text that is meant to be read by the human programmer who is writing or maintaining the code, not by the computer. Comments in Visual Basic 2012 begin with a single quote ('), and everything following on that line is considered a comment and ignored by the compiler. Comments are discussed in detail in Chapter 3.
The MessageBox.Show method displays a message box that accepts various parameters. As used in your code, you have passed the string text to be displayed in the message box. This is accomplished through the concatenation of string constants defined by text enclosed in quotes. Concatenation of strings into one long string is performed through the use of the ampersand (&) character.
The code that follows concatenates a string constant of “Hello,” followed by the value contained in the Text property of the txtName text box control, followed by a string constant of “! Welcome to Visual Basic 2012.” The second parameter passed to the MessageBox.Show method is the caption to be used in the title bar of the Message Box dialog.
Finally, the underscore (_) character used at the end of the lines in the following code enables you to split your code onto separate lines. This tells the compiler that the rest of the code for the parameter is continued on the next line. This is very useful when building long strings because it enables you to view the entire code fragment in the Code Editor without having to scroll the Code Editor window to the right to view the entire line of code.

Private Sub btnOK_Click(sender As Object, 
    e As EventArgs) Handles btnOK.Click
    ‘Display a message box greeting to the user
    MessageBox.Show("Hello, " & txtName.Text & _
        "! Welcome to Visual Basic 2010.", _
        "Hello User Message")
End Sub
The next procedure that you added code for was the Exit button's Click event. Here you simply enter this code: Me.Close().The Me keyword refers to the form itself. The Closemethod of the form closes the form and releases all resources associated with it, thus ending the program:

Private Sub btnExit_Click(sender As Object, 
    e As EventArgs) Handles btnExit.Click
    ‘End the program and close the form
    Me.Close()
End Sub
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